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About Hot Potatoes 
The purpose of the Hot Potatoes is to enable you to create interactive Web-based teaching exercises 
which can be delivered to any Internet-connected computer equipped with a browser. The exercises 
use HTML and JavaScript to implement their interactivity, but you do NOT need to know anything 
about these languages in order to use the programs. All you need to do is enter the data for your 
exercises (questions, answers, responses etc.), and press a button. The program will create the Web 
pages for you, and you can then upload them to your server. 

There are six programs in the Hot Potatoes suite: 
JBC creates multiple-choice quizzes. Each question can have as many answers as you like, and any 
number of them can be correct. Specific feedback is given to the student in response to each 
answer, and a percentage score is displayed after each correct answer is chosen. 

JQuiz creates short-answer quizzes, in which the student types in a word or a sentence in response 
to a question. The sentences are checked against correct answers you have specified (you can have 
as many as you like), and the feedback shows which parts of a student's answer are correct. The 
student can ask for a hint if necessary, and see the next correct letter in the answer. 

JCloze creates gap-fill exercises. Unlimited correct answers can be specified for each gap, and the 
student can ask for a hint and see a letter of the correct answer. A specific clue can also be included 
for each gap. Automatic scoring is also included. The program allows gapping of selected words, or 
the automatic gapping of every nth word in a text. 

JCross creates crossword puzzles which can be completed online. You can use a grid of virtually 
any size. As in JQuiz and JCloze, a hint button allows the student to request a free letter if help is 
needed. 

JMix creates jumbled-sentence exercises. You can specify as many different correct answers as you 
want, based on the words and punctuation in the base sentence, and a hint button prompts the 
student with the next correct word or segment of the sentence if needed. 

JMatch creates matching or ordering exercises. A list of fixed items appears on the left (these can 
be pictures or text), wth jumbled items on the right. This can be used for matching vocabulary to 
pictures or translations, or for ordering sentences to form a sequence or a conversation. 

Conditions for Using Hot Potatoes 
Hot Potatoes is offered free to the educational community by the University of Victoria Humanities 
Computing and Media Centre (formerly the Language Centre), under certain conditions. Hot 
Potatoes is free for use by individuals or educational institutions which are non-profit making, on 
the condition that the material you produce using the program is freely available to anyone via the 
WWW. However, you need to purchase a licence under any of the following conditions: 

• You are working for a company or corporation.  

• You are in business for yourself.  
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• You charge money for access to the material you make with Hot Potatoes.  

• You do not make the material freely available through the WWW.  

For more information on licenses, and details on how to purchase one, check out our Website at: 

 http://www.halfbakedsoftware.com/hotpot/ 

If you intend using the programs to generate more than a handful of exercises, please make sure you 
register. This costs you nothing. 

Hardware and Software Requirements 
• Windows 95, 98, 2000 or NT 4.0 or above (A version of the suite is also available for 

the Macintosh.) 

• A recent version of Netscape Navigator or MS Internet Explorer 

• Access to a Web server (if you wish to deliver your exercises on the Internet) 

If you know HTML and JavaScript, you will be able to exercise more control over the final format 
and style of your exercise pages, but this is not a requirement for creating useful interactive pages 
with Hot Potatoes. 

To use the exercises, your students will also need an appropriate browser. They do NOT need Hot 
Potatoes itself. 

How do the Programs Work? 
There are three stages in creating exercises with these programs: 

Enter your data 
You type in the questions, answers, feedback etc. which forms the basis of the exercise. See 
Entering and saving data for more information on this. 

Adjust the configuration 
The "configuration" is a set of information used to compile the Web pages. It includes instructions 
for the student, captions for navigation buttons, and other information which is not likely to change 
much between exercises. See Configuring the output for more details. 

Create your Web pages 
This is simply a matter of pressing the "Export to Web" button on the toolbar, choosing a file 
name, and letting the program do the rest. See Creating Web pages for further information. 

Entering Data 
The data for your exercise is entered in the main screen of the program. As an example, here is the 
main screen of JQuiz: 
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You can see that there is space to enter the title of the exercise, the current question, and boxes for 
four correct answers to the question. Clicking on the "Up" arrow next to the question number 
allows you to enter a new question. If you want to add more than four correct answers, you can use 
the lower pair of up/down buttons to scroll through correct answers. When all the data is complete, 
you should save your data file. Each program saves files with its own extension: 

JBC:   .jbc 

JQuiz:  .jqz 

JCloze: .jcl 

JCross: .jcw 

JMix:  .jmx 

JMatch: .jmt 

If you want to make changes to your exercise later, you can reload the data file, make the changes, 
and create new Web pages. Please note that you CANNOT RELOAD THE WEB PAGES INTO 
THE PROGRAMS, so it is important to save your data files. 
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Configuring the Output 
The exercises created by Hot Potatoes programs use a variety of buttons and prompts to interface 
with the user (the student). While the data for exercises (questions, answers etc.) will change from 
exercise to exercise, such things as button captions, prompts, and explanations will not change so 
often. These are therefore stored in the form of a configuration file. By default, the six programs 
share the same configuration file, so that common items such as the captions of "Check" or "Hint" 
buttons need to be changed only once. Using the configuration screen, you can set up the programs 
to produce output in any of the languages supported by the 256-character ASCII set (which 
includes any language based on Roman characters, including the accented characters used by many 
European languages) 

Each program provides an interface to the configuration file, accessible through the Configuration 
button on the toolbar, or the Configure output command on the Options Menu. These will bring 
up a screen like the one below, giving access to all the configuration data relevant to the application 
you are using. You can click on the graphic to get more information about items and functions. 
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Here is another page in the configuration dialog. As above, you can click on the graphic to get more 
information about the items: 

 
 

Add a Reading Text 
All of the Hot Potatoes programs give 
you the option to include a reading text 
in a separate frame next to your quiz. 
(The only exceptions to this are the 
drag-and-drop output from JMix and 
JMatch -- doing drag-and-drop inside 
small frames is not practical.) You can 
also include a timer, which will make 
the text disappear after a specified 
number of minutes. The reading text 
may be typed directly into the program, 
or it can be an external Web page that 
you create in some other Web page 
editor. Clicking on Add Reading Text 
from the file menu, or clicking on the  
button on the toolbar, will bring up this 
screen.  
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Adding Graphics 
It is possible to type HTML tags directly into most of the Hot Potatoes text boxes, in order to 
insert images or links into the Web pages. However, if you want to insert a graphic, you can use one 
of the built-in functions to help you. With your cursor in a Hot Potatoes text box, click on the 
Insert menu and choose Picture / Picture from Local File. A dialog box will appear, allowing you to 
select an image from your hard drive. Then you will see the screen below. From this screen, you can 
configure the information which will create the IMG SRC tag and insert it in the text box. Note that 
Hot Potatoes is NOT a WYSIWYG Web page editor; the tools on the Insert menu are only 
intended to help you create HTML code for the page, and you will not see the image until you 
actually compile the page. Also, note that the program automatically creates a relative file path 
between your data file (your .jbc, .jcl or other Hot Potatoes file) and the image file on your hard 
drive. If you do not intend to put your HTML pages in the same place as your data file relative to 
your image files, then you will need to configure the relative path manually to ensure that the image 
appears on your page. This will be much easier if you understand basic HTML. 

Here is the Insert picture screen.  
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Adding Links 
You may wish to insert a link to another Web page in one of the fields in your exercise. To make a 
simple link to a Web page, click on the Insert menu and choose Link / Link to Web URL, and you 
will see the screen below. You can also insert a link to a page on your hard drive by choosing Link / 
Link to Local File; if you do this, you will see a dialog box from which you can choose the file to 
link to, and a relative path between your data file and that file will be created automatically. Note 
that if the file structure you plan to use on the Web server is not the same as that on your hard 
drive, or if you store your Hot Potatoes data files separately from your HTML pages, you will have 
to edit the relative path manually to make the link work. This means understanding some basic 
HTML.   

Here is the Insert link screen.  

 
You can use these link functions to add sound and video to your graphics. 

Adding Sound and Video 
It's increasingly common to add sound and video to Web pages, and this is especially appropriate in 
the case of educational materials. Adding sound or video to your pages is basically no different from 
adding a link to a file; sound files and video files are no different from other files. Here are some 
basic guidelines, and a couple of example scenarios. 

First, create your media files. 

Hot Potatoes does not contain any tools for creating or editing sound or video files. For this, you 
will need to find other software programs. Most modern sound cards can be used for recording or 
capturing sound on disk, but you may need to get some special software with which to edit it. Video 
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is a little more complicated, since you may need a video card which has video capture capabilities, 
and not all video cards can do this. 

Linking to a simple sound file 
Let's imagine that you have a sound file called listen.wav. (WAV files are a common sound file 
format, usually created on Windows, and used for short sound segments.) The file is sitting in the 
same folder as your JBC exercise. You would like your students to be able to listen to this file before 
they answer Question 1 of your JBC quiz. Here's what you do: 

1. Make sure you have saved your JBC exercise. 

2. Click in the Question field of Question 1 in JBC. 

3. Click on Insert / Link / Link to Local File. 

4. If a message appears, read it and make sure you understand it, then press OK to bring up 
the Open File dialog box. 

5. Find your sound file and select it, then press Open. You will now see the  Insert Link dialog 
box. 

6. In the case of a sound file, you probably should not specify a Target attribute -- leave this 
box blank. 

7. In the Link Text box, type an appropriate piece of text, such as "Click here to listen to the 
text". 

8. Press OK. 

Now, when you compile your Web page, you should see a link in Question 1. Clicking on the link 
will play the sound file. Note that how the file is played (what application is used to play it) really 
depends on the user's browser. Sometimes QuickTime will pop up, sometimes the Windows Media 
Player, and sometimes another application; it all depends on what is installed on the user's machine, 
and you have no control over that. However, something should always appear which can play the 
file, as long as the user's computer is able to handle sound. 

There are several other types of sound files that you can use; among other popular types is 
RealAudio, which is played by a free plug-in. RealAudio files are very compressed, and can be much 
smaller than WAV files. You can encode your own sound files in RealAudio format using a free 
encoder. http://www.real.com 

Linking To a Video File 
Linking to a video file is really no different from linking to a sound file. Just follow the steps above, 
but select a video file instead of a sound file. However, you should note that, in order to view the 
video, your user's computer must be able to handle the specific video format you have chosen. It's a 
good idea to do extensive testing on various types of machine to make sure that your video is in a 
format which the user can play. If you're using a format such as RealVideo, you might want to 
include a link on the page so that users can download and install the RealVideo plug-in if necessary. 
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Creating Web Pages 
When your data is ready, and you have checked the Configuration information, you are ready to 
create a Web page. Creating Web pages is the simplest part of using Hot Potatoes. Use the Export 
to Web command, accessible through the File menu or the toolbar: 

All of the Potatoes use the same command to create a version 5 export file, which is a single HTML 
file. You can post this file on your server, and the exercise will appear when you load it. If you are 
using JMix or JMatch, there are other options, however. JMatch has two other output formats: one 
is a flashcard output, which you can use to let your students practice or memorize something before 
quizzing them on it, and the other is a drag-and-drop form of the exercise. JMix also has a drag-and-
drop format. HotPot version 5 drag-and-drop exercises should work on the following browsers: 

Windows: Internet Explorer 5.5 and above; Netscape Navigator version 6 and above. 

Macintosh: Internet Explorer version 5 and above; Netscape Navigator version 6 and above. 

Creating and Viewing Your Pages 
When you have selected the type of output you want, and specified a file name, the Web page will 
be created. The program will then ask you if you wish to see the exercise in a browser. If you say 
yes, then your default browser program will be launched, and the exercise will be loaded into it. You 
can check that the results match your expectations. 

Choosing Good Filenames 
If you enter a file name containing a space, the program will warn you that this is not a good idea; 
the reason for this is that on many Web servers, spaces will be replaced with "%20", and therefore 
the URL of your document may not be what you expect it to be. It's best to avoid spaces in the file 
names of Web pages. 

How to Link a Series of Exercises 
A common way to use Hot Potatoes is to create a series of linked exercises, so that the student does 
one after another in sequence. You can easily do this by creating an Index page, and having students 
jump to each exercise, do it, then jump back to the index and choose another one. However, Hot 
Potatoes allows you to link exercises in a simpler way, using the Next Exercise, Contents and Back 
buttons. 

In any of the Potatoes, if you go to the Configuration screen and click on the Buttons tab, you will 
see settings for these three buttons. You can decide whether or not to include the buttons, and you 
can set the caption that will appear on the buttons. If you want the buttons to work, though, you 
will have to tell the program where the next exercise and the contents page actually are, so the 
button can jump to them. To do that, just enter the URL or path to the next exercise in the correct 
box, then do the same with the contents page. Note that these can be complete URLs, beginning 
with http://..., or they can be relative URLs. In the simplest case, if the current exercise and the 
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next exercise will be in the same folder, then all you need to enter is the filename of the next 
exercise. 

Here's an example: 

1. You're making a page called exercise1.htm, and you want to link it to exercise2.htm. Both of 
these files will be in the same folder. 

2. Open the first page in your Potato. 

3. Go to the configuration screen (Buttons tab). 

4. Make sure Include "Next Exercise" button is checked. 

5. Enter "exercise2.htm" in the Next Exercise URL text box. 

6. Press OK, and then compile your Web page. 

7. You should see a Next Exercise button on the page. When you click on it, the browser will 
go to exercise2.htm (providing that exercise2.htm exists). 

The Contents button works the same way as the Next Exercise button, but the Back button is 
different -- all that does is to take you back to whatever page you were on before (like pushing the 
back button on your browser toolbar). 

Help With Each Potato 
JBC 

JBC is used to create multiple-choice or true/false quizzes. This is the main screen of the JBC 
program. Click on the graphic for further information on how the program works. 

Exercise Title 
The title of the exercise or quiz you are currently working on should be entered in this box. It will 
become the main heading of the Web page you create. 

Question 
To move from question to question, click on the up or down arrows next to the question number 
(or use the Page Up and Page Down keys on your keyboard). 

Correct answers 
Use these check boxes to specify whether an answer is correct or not. You can specify as many 
correct answers as you want for each question. 

Feedback 
"Feedback" is what you want the user to see when he or she clicks on any particular answer. This 
might be as simple as "Correct!" or "Wrong!", but usually it will be something more helpful, 
explaining why an answer is not correct, or giving extra information to help the student. Note that 
you can fill these boxes in automatically if you wish, using Auto-response on the Manage Questions 
menu. 
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Configuring JBC 
The configuration information for JBC is quite extensive, since it includes the options for adding a 
Reading text, as well as several more options not present in other programs on the DHTML tab. 
Note that DHTML options (such as the option to shuffle the order of questions or answers each 
time a Web page loads) are not functional if you choose the version 3 (HTML) output. 

Note that when adding captions for the A, B, C, D and E buttons for the multiple-choice answers, 
it is a good idea to include a space before and after the letter; if you don't do this, the buttons will 
appear too small in some browsers. In other words, " A " is better than "A". 

JQuiz 
JQuiz is used to create short-answer quizzes in which the student types in his or her answer, which 
is then checked..  

Exercise Title 
The title of the exercise or quiz you are currently working on should be entered in this box. It will 
become the main heading of the Web page you create. 

Acceptable answers 
 JQuiz allows you to specify up to four different correct answers that will be acceptable. This means 
that you can allow for variations in word-order, punctuation or vocabulary. For example, for the 
question "What time does the party start?", you might want to allow "Four thirty" or "Half past 
four". If you don't need to allow multiple correct answers, just leave the last three boxes blank. The 
most likely, standard or important correct answer should be entered first. 
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Using angle brackets in JQuiz 

Angle brackets << >>  are the delimiters for HTML tags, so they can cause problems when used 
inside JavaScript functions which write to other frames. For this reason, you should avoid using 
angle brackets in the answers of a JQuiz quiz. It's OK to use them in the question, so long as you 
are aware that they will be treated as HTML code. (This means that you could include a picture in 
your JQuiz question by adding <IMG SRC="mypic.gif"> in the question box.) Similar limitations 
apply to other HTML codes and tags. Make sure your correct answers are all plain text only. 

Configuring JQuiz 
The configuration for JQuiz includes a lot of prompts, because the exercises give extensive 
feedback to the student about the answer he or she has entered. Also, note that you can choose (on 
the Settings page of the Configuration dialog) whether to make answer-checking case sensitive or 
not. In normal circumstances, if you are making short-answer quizzes, it would probably make sense 
to have case-sensitivity switched off, so that it doesn't matter whether the student enters an answer 
in upper case or lower case. However, if your quiz asks for answers in sentences (as for example in 
the case of a grammar exercise), then using the correct case where necessary might be part of the 
exercise. In this case, case-sensitivity should be turned on. 

JCloze 
JCloze creates gap-fill exercises. Unlimited correct answers can be specified for each gap, and the 
student can ask for a hint and see a letter of the correct answer. A specific clue can also be included 
for each gap. Automatic scoring is also included. The program allows gapping of selected words, or 
the automatic gapping of every nth word in a text. 
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This is the main screen of JCloze.  

 

Exercise Title 
The title of the exercise or quiz you are currently working on should be entered in this box. It will 
become the main heading of the Web page you create. 

Gap button 
To create a gap in the text, select the word or words you wish to gap, and then press the Gap 
button. The selected text will change color, and you will see a dialog box in which you can enter 
alternative answers for the gap, and a specific clue for that gap, if you wish. 

Delete gap button 
If you want to restore a word or phrase that you have gapped, click on the word (no need to select 
it) and press this button. 

Clear gaps button 
If you want to remove all the gaps you have added to the text, and start again with a fresh text, press 
this button. 

Auto gap button 
True cloze exercises are created by gapping every nth word in a text (every 4th word, for example), 
rather than choosing which words to remove. You can do this automatically in JCloze by clicking 
on this button, and specifying the value of n. 

Show words button 
While working on your text, you may wish to access and edit the list of alternate correct answers 
and clues. Press the Show words button to bring up the alternate correct answers and clues screen. 
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Adding alternate correct answers 
When you gap a word in JCloze, you will see a screen like the one to the right.  

 
Gapped word 
This is the original word or phrase from the text, which will be gapped in the Web page output. 

Gap clue 
Here you can enter a clue for this particular gap. If you add a clue (and make sure that "Include clue 
button" is checked on the Button Captions tab of the Configuration panel), then a small button will 
appear next to the gap; when the student presses the button, the clue will appear. 

Alternatives 
Here, you can enter up to 100 alternative correct answers for the gapped word or phrase. For 
example, if your gapped word is "student", you might also wish to accept the answers "learner" and 
"pupil". You can scroll through the list of alternates using the Up and Down buttons. 

Configuring JCloze 
There are only three unusual settings in the configuration of JCloze.Two are on the Settings/URLs 
page of the Configuration dialog box. Make answer-checking case sensitive allows you to switch on 
or off case-sensitivity on the Web page (as you can do in JQuiz). Include word list below text allows 
you to include a list of the gapped words from the text, mixed up, in a box at the top of the page, to 
make the exercise a little easier. 

The third is Include clue button for each gap, which is on the Button Captions page. If you have 
specified clues for your gaps, check this option to make sure that a button will appear next to each 
gap which has a clue associated with it, so the student can see the clue. See Adding alternate correct 
answers and clues for more information on this. 
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JCross 
JCross creates crossword puzzles which can be completed online. You can use a grid of virtually any 
size. As in JQuiz and JCloze, a hint button allows the student to request a free letter if help is 
needed. 

 
Exercise Title 
The title of the exercise or quiz you are currently working on should be entered in this box. It will 
become the main heading of the Web page you create. 

Crossword grid 
You can create your crossword on this 20 x 20 grid. Enter your letters using the keyboard, and 
move from square to square using the arrow keys. It doesn't matter how large or small your 
crossword is within the grid; when you create the Web page, the unused squares will be trimmed 
from the grid automatically. Note that if you have not registered yet, you will only be allowed to use 
an 8 X 8 grid. 

Creating very large crosswords is easy, but viewing them in a small browser window is not; it's a 
good idea to keep your grid as small as possible unless you know your users will have very large 
monitors. 

Add clues button 
When you have finished creating your grid of words, you can click on this button. 
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Grid shifting keys 
When creating a grid, you will often find that you run up against the side of the grid on one side, 
while there is plenty of space on the other. Using these buttons, you can shift the letters you have 
entered around on the grid. 

Entering clues 
When you have created your grid, you can click on the Add Clues button to enter clues for all your 
words. At this point, the program will work out the numbers of the words, and show you the screen 
below. Note that even after this, you can make any changes you wish to the grid; the program will 
remember the clues you already entered and match them up with the correct words again, even if 
you move the words around on the grid. 

This is the Add Clues screen.  

 
Clue numbers 
Clue numbers are assigned automatically by the program. You don't need to worry about this. 

Words  
The words you have entered into your grid will appear here. 

Definitions 
Enter your definitions in here. They will be preserved even if you make changes to the grid later.  

Note that in the definitions boxes, you can access standard editing commands such as Copy and 
Paste by using the right-click (context) menu. You can also insert pictures and links by using the 
Insert menu. 
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Configuring JCross 
Most of the configuration options for JCross are the same as those in the other programs. 
Exceptions are crossword labels such as Clues Across and Clues Down, and one item on the 
DHTML tab, Include keyboard navigation for grid. When this option is checked, the user should be 
able to move around in the crossword grid using the keys specified. If you are creating crosswords 
for mathematics, you might want to disable this, so that your students can enter the numbers 2, 4, 6, 
and 8, rather than having these keys act as navigation keys. 

JMix 
JMix creates jumbled-sentence exercises. You can specify as many different correct answers as you 
want, based on the words and punctuation in the base sentence and a hint button prompts the 
student with the next correct word or segment of the sentence if needed. 

 
Exercise Title 
The title of the exercise or quiz you are currently working on should be entered in this box. It will 
become the main heading of the Web page you create. 

Main sentence 
This is where you enter the main sentence which will be mixed up to create the exercise. Note that 
in version 4 of JMix, you need to break the sentence up into segments yourself; previous versions 
would break up the sentence for you, but did not allow you to have segments larger than one word 
or one piece of punctuation. Break up the sentence by putting each segment on a separate line.  
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Breaking up the sentence into segments 
You can break up the sentence yourself into separate segments, making them as big or as small as 
you like. To do this, just put each segment on a separate line. For example, to break up the sentence 
"Yes, we have no bananas." into segments, you would type this into the main sentence box: 

 Yes 

 , 

 we 

 have 

 no 

 bananas 

 . 

Note that the comma and period are also on separate lines, so that they become separate segments. 

This may seem like a little more work than before, but consider the advantages -- now you can have 
longer segments consisting of multi-word phrases such as "University of Victoria". Also, you can 
break up one word into individual letters, to create a mixed-up word puzzle. 

Alternate sentences 
You may wish to allow alternate correct sentences which will be accepted by the program. For 
example, if your main sentence is "The potato, a root vegetable, is a staple food in England.", the 
you may wish to add the alternate sentence "The potato, a staple food in England, is a root 
vegetable." You can also include sentences which do not use all of the words and punctuation in the 
original if you wish -- for example, "The potato is a root vegetable." However, if you enter a 
sentence that contains a word or piece of punctuation which is not in the original sentence, the 
program will warn you. 

You can enter up to 100 alternate sentences. Use the Up / Down buttons to move through the 
alternate sentences. 

Alternate sentence options 
 You may wish to restrict your students to creating sentences which use all of the elements in the 
original sentence; on the other hand, you may be prepared to allows shorter sentences which do not 
use all the elements to be accepted as correct. Setting the option here allows the program to check 
the alternate sentences for you when you start to create a Web page. 

Breaking up the sentence into segments 
In many languages (including English), the single quotation mark ( ' ) is used both as an apostrophe 
and as a quotation marker: 

 He said, 'I need help.' (quotation marker) 

 I'm listening. (apostrophe) 
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In a JMix jumbled sentence exercise, it is difficult for the program to tell which of these is intended. 
The single quotation is therefore always treated as an apostrophe; if you want to use quotation 
marks, please use the double quotation ( " ) in JMix. It's probably best to avoid quotation marks 
altogether if you can. 

Also, the angle bracket characters ( < and > ) are sometimes problematic on Web pages since they 
are the delimiters for HTML tags, so these should be avoided unless you are using HTML tags on 
purpose -- for example, by creating a drag-and-drop (V4 output) page which uses pictures instead of 
words. 

Configuring JMix 
JMix has more buttons than the other programs, because the HTML (V3) output exercises allow the 
student to Undo previous actions, and both forms of output include Hint and Restart buttons. As in 
all the programs, however, all these buttons except for the Check button are optional. 

The Settings/URLs page of the Configuration screen has a new item, Always capitalize first letter. 
When this option is checked, the first letter of the student's answer will be capitalized (as it should 
be in a normal sentence) while the exercise is being completed. If you are compiling for DHTML 
(V4) output, note that this option can cause slightly annoying behaviour under Internet Explorer 5; 
it can cause the text on multiple segments to become selected. You might therefore want to turn the 
option off if many of your users will be using IE5. Also, if you are creating mixed-up-word puzzles 
(by breaking up one word into separate letters), then you will probably want to turn this off. 

JMatch 
JMatch creates matching or ordering exercises. A list of fixed items appears on the left (these can be 
pictures or text), wth jumbled items on the right. This can be used for matching vocabulary to 
pictures or translations, or for ordering sentences to form a sequence or a conversation. 
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Exercise Title 
The title of the exercise or quiz you are currently working on should be entered in this box. It will 
become the main heading of the Web page you create. 

Left (ordered) items 
These are the items which will appear on the left of the Web page, in fixed order. They may include 
pictures or links. The items on the right, which match them, will be jumbled up. 

Right (jumbled) items 
These are the items which will form the jumbled series on the Web page. If you are exporting to 
plain HTML (V3 output), then they may only consist of text, and cannot contain carriage returns, 
but if you are creating V4 output (DHTML), then you can include pictures.  

You can now include "distractors" (answers which appear on the right but have no match on the 
left). To create a distractor, just add an extra item on the right at the bottom of your item list, with 
nothing in the corresponding text box on the left. 

Another improvement in version 4 is the ability to handle multiple instances of the same item on 
the right. There is now no need to limit yourself to unique items on the right. 

Move through items 
Use these buttons to move through the list of items. You can have up to 100 items in JMatch 
(although this is limited to 5 before you register). 

Fix item 
This checkbox enables you to "fix" some items in the matching exercise.  

You might use fixed items in many ways. For example, if the exercise involves putting sentences 
into a correct sequence, you might "fix" the first sentence to give the student somewhere to start 
from. You can also use fixed items to demonstrate to the student how to do the exercise, especially 
in the case of the DHTML output. 

Default label 
The default label is only used if you are creating plain HTML (V3) output, in which the items on the 
right will be turned into a drop-down list box. This is the piece of text that will appear at the top of 
each drop-down list of jumbled items when the page is first loaded. It can be anything you like -- a 
space, "???", or even an instruction such as "Choose the matching word". 

Configuring JMatch 
The configuration options for JMatch are much fewer than for the other applications, because the 
exercises are much simpler. You may not find it necessary to include any instructions at all on the 
page, but there are boxes for an exercise subtitle and instructions if you need them.  
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